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About this guide

This Web Essentials Guide explains how to use the Web Reporter 
Web interface to report on library data. It explains how to access the 
software, configure various views of data, and view reports. It also 
explains how to work with report data to create new reports and 
charts.

This guide is intended for library staff who work with reports and 
for  system administrators who must understand and support basic 
features of the software.  The guide assumes that you have a 
general knowledge of library data.

Setup and administration topics are not covered in this guide.  

For more information about this guide, see these topics:

• Summary of contents on page v

• Conventions used in this guide on page vi

• Software basics on page viii

• Possible differences between the software and this guide on 
page viii

• Documentation updates on page ix

• Comments and suggestions on page ix

Summary of contents
This guide contains these major sections:

Chapter 1, “Using Web Reporter HTML Help,” on page 1

Chapter 2, “Getting Started,” on page 11

Chapter 3, “Basic User Tasks,” on page 37
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Conventions used in this guide
This guide uses terms, typefaces, and symbols to denote different 
kinds of information.  Understanding these conventions can help 
you recognize the information you need more quickly.

Symbols

This guide uses these symbols:

Mouse conventions

The following terms are used in this guide to describe actions you 
do with a mouse.

Symbol Description

Tip

This symbol indicates additional notes or helpful tips.

Important

This symbol indicates important information or 
warnings.

Term Definition

Click To place the mouse pointer on an icon, command, or 
button and quickly press and release the primary 
(usually the left) button once.

Double-click To place the mouse pointer on an icon, command, or 
button and quickly press and release the primary 
mouse button twice.

Right-click To place the mouse pointer on an icon, command, or 
button and quickly press and release the secondary 
(usually the right) button.

Drag To press and hold the primary mouse button while 
moving the mouse.
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Keyboard conventions

This guide refers to keys following the standard convention of 101-
key keyboards. For example, Ctrl is the control key, Alt is the 
alternate key, Enter is enter or return.

When you need to press two or more keys at the same time to do an 
action, the keys are connected with a plus sign (+). For example, 
Alt+H means to press and hold the Alt key while you also press H.

Keys you press appear in bold type in steps. Text or numbers that 
you need to enter using the keyboard also appear in bold (for 
example, “Type main in the Location field”).

Other conventions

In step-by-step instructions, the names of menus, buttons, fields, 
and other options appear in bold type (for example, “the OK 
button” or“the Title field”).

When you are instructed to choose an option from a menu, the 
menu and menu options are separated by the greater-than symbol 
(>). For example, “choose File > Save” means to choose the File 
menu then choose the Save option from the menu. This convention 
is also used to show the sequence of items you use to open a report 
or feature in the software.

Text in italics shows general information that you must replace 
with information that is specific to your system. For example, you 
would replace password with a specific password, such as 
123gr@ndma.

Choose To click a button or an option from a menu, group of 
options, or list.

Select To click once on an option in a list so that the option is 
highlighted. In a field, you may drag the mouse over 
text to select that text.

Term Definition
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File and directory names, code examples, and computer output 
appear in Courier.

Software basics
This guide assumes that you have a basic knowledge of your 
workstation operating system and of working with software that 
presents information in a Web browser. At a minimum, you should 
know how to:

• Use a mouse or keyboard to do basic tasks, such as choosing 
menu options and buttons.

• Work with windows (selecting, moving, minimizing, restoring, 
maximizing, sizing, scrolling, closing, and so on).

• Work with dialog boxes.

• Log in to the software, change operators, and log off the 
software.

• Work in software list and edit windows.

Possible differences between the software and this 
guide

The names, labels, and sample windows in this guide reflect the 
default settings that are delivered with most new installations. The 
settings on your system may be different from these defaults, 
depending on your library’s implementation choices and the way 
your system administrator sets up your system. (For example, your 
system administrator can change report names, reorganize the 
items that display in Shared Reports, and set up security to limit 
access to certain features.)

If you do not know how to do these tasks, refer to the 
documentation for your workstation operating system and your 
Web browser.
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Additionally, as you use the software, you can resize windows or 
customize your workspace. Consequently, your software 
environment may look and function differently than the 
environment described in the tasks in this guide.

Documentation updates
Updates to this guide are posted to the customer support website 
between releases, as necessary. These updates provide corrections 
to unclear, incorrect, or incomplete information. They also provide 
documentation for enhancements that were not complete at the 
time the guide was first published.

You may access the customer support website at http://
clientcare.sirsidynix.com.

Comments and suggestions
SirsiDynix welcomes and appreciates your comments on its 
documentation. We want to know what you think about our 
manuals and how we can make them better. If you have comments 
about this guide, please send them to docs@sirsidynix.com.

Be sure to include the title and version number of the guide and tell 
how you used it. Then tell us your feelings about its strengths and 
weaknesses and any recommendations for improvements.

The customer support website requires a user name and 
password. If you do not already have a user name and password, 
contact your system administrator to receive one.

http://clientcare.sirsidynix.com
http://clientcare.sirsidynix.com
mailto:docs@sirsidynix.com
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Chapter 1: Using Web Reporter 
HTML Help

The HTML Web Essentials Guide for Web Reporter provides 
instructions and reference information to help you make the most 
of the software. For an overview of the content and conventions in 
this guide, see About this guide on page v.

You can access the help in one of several ways described in 
Learning about Web Reporter on page 22.

Once the help is open, you can find help topics by using the 
Contents, Index, and Search features. You can move back and forth 
between help topics by using the browse buttons or by following 
links. Once you’ve found the help you need, you can print or 
bookmark topics for later reference.

For more information, see these topics:

• HTML help features on page 1

• Finding specific information on page 4

• Moving between help topics on page 6

• Printing a topic on page 7

• Bookmarking a topic on page 7

HTML help features
The guide is designed to help you find what you need quickly. 
Topics are brief and include references to related topics if you want 
to learn more.
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Each topic displays in a content pane with a toolbar at the top for 
additional help features. A navigation pane lets you browse the 
contents of the guide, find topics using the index, or search for 
specific information.

Toolbar

The help toolbar includes these buttons.

Help toolbar

Content pane

Topics 
teach you 
step by 
step

Click a 
link to see 
a related 
topic

Navigation pane

Button Description

Next Displays the next topic in contents order. This button 
is inactive when you are viewing the last topic in the guide.

Previous Displays the previous topic in contents order. 
This button is inactive when you are viewing the first topic 
in the guide.

Show in Contents As you browse topics or follow links, 
this button lets you find the current topic in the contents. 
This button does not appear if the navigation pane is 
hidden.
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Navigation Pane

The navigation pane lets you quickly locate help topics using 
Contents, Index, or Search. For details, see Finding specific 
information on page 4.

Depending on how you access the guide, the navigation pane may 
be hidden. If it’s hidden, you can simply click the Show Navigation 
button  to display the navigation pane.

Related topics

• Finding specific information on page 4

• Moving between help topics on page 6

• Printing a topic on page 7

• Bookmarking a topic on page 7

• Displaying the navigation pane on page 8

Show Navigation Opens the navigation pane. This button 
only appears if the navigation pane is hidden.

Related Topics Displays links to topics related to the 
current topic. Related topics also appear at the end of most 
help topics. This button is inactive if the current topic does 
not have any related topics.

Email Lets you send comments about a topic to SirsiDynix. 
This feature uses the email agent associated with the 
“mailto” protocol on your operating system.

Print Prints the current topic, without the toolbar or 
navigation pane.

Bookmark Lets you bookmark the current topic in Firefox. 
This button is not supported in Internet Explorer (see 
Bookmarking a topic on page 7 for an alternative).

Button Description
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Finding specific information
Use Contents, Index, or Search to find specific information. You can 
also open specific topics using context options in the software.

For details, see these topics:

• Using contents on page 4

• Using the index on page 4

• Searching for help topics on page 5

Using contents

The HTML guide includes a contents list to help you quickly 
navigate to specific topics in the guide.

To display a topic using the table of contents

1 Click Contents. (If you don’t see the Contents feature, click the 
Show Navigation button  to display the navigation pane.)

2 Click the icons beside an item to expand or collapse that item.

3 Click an item to view that topic.

4 As you browse topics and follow links, click the Show in 
Contents button  to see where the current topic appears in 
the table of contents.

Related topics

• Using the index on page 4

• Searching for help topics on page 5

• HTML help features on page 1

Using the index

The index in the HTML guide is very like an index in a book.
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To find information using the index

1 Click Index. (If you don’t see the Index feature, click the Show 
Navigation button  to display the navigation pane.)

The software displays the index with index groups at the top 
for quick access.

2 Click an index group to view that group of terms. For example, 
click M to view the words in the index that begin with the letter 
“M”. 

3 Click an index term to view the topic or topics for that term.

4 If more than one topic fits that term, the software displays a list 
of matching topics. Click an item in the list to view the topic.

Related topics

• Using contents on page 4

• Searching for help topics on page 5

• HTML help features on page 1

Searching for help topics

If you can’t find what you need using the contents or index, you 
can search for words using the Search feature.

The Search feature of the HTML guide returns results ranked by 
relevance. The ranking considers frequency (the number of times 
the words appear in a topic), proximity (how close the words are, 
when you use more than one word), and importance (if the words 
appear in topic headings, for example). 

When you enter more than one word, all the words you enter must 
appear in a topic to be considered a match. If you don’t get any 
results, try removing some words.

Common words (such as “and”, “for”, “that”, and so on) are 
ignored when you search.
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To search for help topics

1 Click Search. (If you don’t see the Search feature, click the 
Show Navigation button  to display the navigation pane.)

2 Enter one or more words to search for.

3 Choose Go.

The software returns a relevance-ranked list of topics matching 
the words you entered.

4 Click an item in the list to view that topic.

Related topics

• Using contents on page 4

• Using the index on page 4

• HTML help features on page 1

Moving between help topics
You can move from one topic to another by using the browse 
buttons in the toolbar or by clicking on links you see.

As you browse topics and follow links, click the Show in Contents 
button  to see where the current topic appears in the table of 
contents. If you don’t see the Contents feature, click the Show 
Navigation button  to display the navigation pane.

To move to the next or previous topic in sequence

1 To display the next topic in the guide, click the Next  button 
in the toolbar.

2 To display the previous topic in the guide, click the Previous 
button  in the toolbar.

To display linked topics

1 Click a linked topic.
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2 Right-click and choose Back or use your browser’s Back button 
to return to a topic you were viewing before following a link.

Related topics

• HTML help features on page 1

• Finding specific information on page 4

• Printing a topic on page 7

• Bookmarking a topic on page 7

• Displaying the navigation pane on page 8

Printing a topic
The Print option lets you print the current topic, without printing 
the toolbar and navigation pane.

To print a single topic

1 Open the topic you want to print.

2 Click the Print button  in the toolbar.

Related topics

• HTML help features on page 1

• Finding specific information on page 4

• Bookmarking a topic on page 7

Bookmarking a topic
If there is a particular topic that you refer to often, you can 
bookmark it for quick reference.

To bookmark a topic in Firefox

1 Locate the topic you want to bookmark.

2 With the topic displayed, click the Bookmark button  in the 
help toolbar.
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The software displays a new window with a link for this topic.

3 Right-click the link and choose Bookmark This Link from the 
menu that appears.

4 If you want to, specify a location for the bookmark.

5 Choose OK.

To bookmark a topic in Internet Explorer

1 Locate the topic you want to bookmark.

2 With the topic displayed, right-click anywhere in the content 
pane (see HTML help features on page 1).

3 Choose Add to Favorites from the menu that appears.

4 If you want to, specify a location for the bookmark.

5 Choose OK.

Related topics

• HTML help features on page 1

• Finding specific information on page 4

• Printing a topic on page 7

Displaying the navigation pane
Depending on how you open the HTML guide, the navigation pane 
may be hidden. When the navigation pane is hidden, you will see 
the Show Navigation button  in the help toolbar in place of the 
Show in Contents button .

To display the navigation pane.

Click the Show Navigation button .
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Related topics

• HTML help features on page 1

• Finding specific information on page 4

• Moving between help topics on page 6
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Chapter 2: Getting Started

Welcome to Web Reporter, a full-featured business intelligence tool 
that helps you take advantage of data in your integrated library 
system without the need to be an SQL programmer.

Web Reporter includes a set of base reports to let you view and 
analyze your data in different ways. From these reports, you can 
create other reports and dashboards to provide quick access to the 
information that is most important to you.

Web Reporter features a Web interface that let’s you create and run 
reports from a standard Web browser. (A desktop client is also 
available for Desktop Professional users. For information about the 
Desktop application, refer to the MicroStrategy manuals installed 
with the Desktop software. See Learning about Web Reporter on 
page 22.)

To get started, choose one of these topics:

• Using Web Reporter on page 11

• Using Web Reporter HTML Help on page 1

• About Web Reporter on page 12

• Learning about Web Reporter on page 22

Using Web Reporter
Web Reporter is a Web-based software tool you can use from 
anywhere that you have access to the World Wide Web. Your 
system administrator will provide you with the URL to access Web 
Reporter for your library.

Please be aware of these minimum requirements:

• Microsoft Internet Explorer 6.0 or later
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• Firefox 2.0 or later

• 800 x 600 minimum screen resolution (1024 x 768 or higher 
recommended)

• Adobe Reader for printing and viewing PDF reports

As a Web application, Web Reporter uses JavaScript, popups, and 
cookies for many features. If JavaScript, popups, or cookies are 
disabled or unsupported in your browser, some features will not 
work.

Some features of Web Reporter depend on privileges assigned to 
your user account, your user license level, and what optional 
software services are available to you (OLAP Services, for 
example). Because of this, you may not have access to some 
features described in this guide. Also, you may see different graphs 
or reports that display different data than other users see.

If you need help logging in or have questions about access, contact 
your system administrator.

To learn more about Web Reporter, choose one of these topics:

• Using Web Reporter HTML Help on page 1

• About Web Reporter on page 12

• Learning about Web Reporter on page 22

• Logging in on page 23

• Logging out on page 25

• Getting around in Web Reporter on page 26

• Changing your password on page 25

About Web Reporter
Web Reporter is a business intelligence tool that helps you analyze 
and report on your library data. Based on the MicroStrategy 
Business Intelligence Platform, Web Reporter is very powerful yet 
easy to use. You don’t have to be an expert with SQL or database 
technologies. A simple interface lets you filter, sort, and run reports 
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as easily as answering a few prompts. Depending on your user 
level, you may also be able to cross tabulate and pivot your data in 
different ways, in the end building graphs and reports that reveal 
and illustrate key measures important to your organization. You 
can then export these results for further analysis or share them with 
others in PDF.

As you work with Web Reporter and use this guide, it will be 
helpful to understand these topics:

• Web Reporter user levels on page 13

• Web Reporter architecture overview on page 16

• Web Reporter Web interface on page 18

• Terms on page 20

Web Reporter user levels

Each user in your organization that uses Web Reporter must have a 
separate license. You purchase Web Reporter licenses depending on 
the level of functionality needed. Licenses are available for these 
user levels.

• Web Reporter

• Web Analyst

• Web Professional

• Desktop Designer

Each license adds functionality. For example, the Web Analyst can 
typically do all that the Web Reporter can do and more; the Web 
Professional can do all that both Web Reporter and Web Analyst 
can do.

Here is a brief description of each user level.
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Web Reporter

The Web Reporter user has the least functionality and is intended 
for light use. A Web Reporter license allows users to run and view 
existing reports, answering any prompts defined for the report to 
select or filter data, for example. After running the report, a Web 
Reporter user can sort data, drill to see additional information (if 
available), print the report, or export report data for use in another 
application. Web Reporter users can also schedule reports to run 
according to schedules defined by a system administrator.

Web Reporter users cannot create reports except by using prompts 
and report builders already provided by other report designers. 
They also cannot save reports.

Web Analyst

The Web Analyst license is appropriate for a medium user. In 
addition to the functionality of the Web Reporter license, this 
license allows users to change the way data displays on a report 
including swapping rows and columns (pivoting) and changing the 
order of columns. Web Analyst users can also add and format 
metrics.

Web Analyst users who are also licensed to use OLAP Services (a 
separate purchase) can use view filters and hide or show specific 
report objects to focus on the most significant data in a report.

After creating customized reports, Web Analyst users can save the 
results. When saving, you can choose to keep the answers you 
specified for prompts or prompt again when you run the newly 
customized report.

Web Analysts cannot change the look of a report grid (advanced 
formatting options such as fonts, alignment, colors, or borders, for 
example), and they cannot use objects that are not already part of a 
report.
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Web Professional

The Web Professional license is for super users. This license 
includes all the features of the Web Reporter and Web Analyst 
licenses and allows users to create reports from scratch or modify 
existing reports in design mode. Web Professional users can add 
and remove objects, customize grid format, and create and save 
filters.

Desktop Designer

Some reporting features are only available though the 
MicroStrategy Desktop application, not the Web client. For these 
features, you need a Desktop Designer license (also known as 
Desktop Professional). Features that require Desktop Designer 
include creating drill maps and configuring drilling; creating and 
saving prompts and adding them to reports; creating metrics, 
thresholds, and custom groups; and defining banding and 
autostyles.

Since these features are not available in the Web interface, they are 
not covered in this Web Essentials Guide. Instead, refer to the 
MicroStrategy documentation that is installed with the Desktop 
application (see Learning about Web Reporter on page 22). 
Everything you can do in the Web client, you can also do in the 
Desktop client.

Related topics

• Web Reporter architecture overview on page 16

• Web Reporter Web interface on page 18

• Terms on page 20

• Learning about Web Reporter on page 22

• Basic User Tasks on page 37
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Web Reporter architecture overview

Web Reporter is a suite of modules based on the MicroStrategy 
Business Intelligence Platform. It consists of an Intelligence Server 
that uses metadata about your ILS (integrated library system) 
database to gather information, a Web server that allows you to 
view and edit reports from a Web browser, and a Desktop client 
used for administration and report design tasks not available 
through the Web interface.

MicroStrategy Web and Intelligence Server software are typically 
installed on a single Web Reporter server apart from the ILS 
database server. The Desktop client is also included on the Web 
Reporter server, but a system administrator may choose to install 
Desktop on additional administrator workstations as needed. A 
Desktop Designer license is required for each Desktop user (see 
Web Reporter user levels on page 13).

Figure 2-1 illustrates the relationships between components.
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Figure 2-1: Web Reporter architecture

MicroStrategy Intelligence Server is at the core of Web Reporter. It 
provides security, data caching, and analytical capabilities beyond 
the ILS database. The Intelligence Server uses ODBC (open 
database connectivity) to connect to two databases used for 
reporting. One is the ILS database that holds your library data. The 
other is a metadata database.

The metadata database provides the Intelligence Server with 
information about your ILS database and information about the 
reports and report objects you can work with. It also includes Web 
Reporter configuration data, such as security policies, user data, 
and project information, for example.
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When you create or run reports, Intelligence Server uses this 
metadata to translate your requests into SQL queries for the ILS 
database and then translates the results into the report objects and 
documents you work with in the Web or Desktop clients.

Related topics

• Web Reporter user levels on page 13

• Web Reporter Web interface on page 18

• Terms on page 20

• Learning about Web Reporter on page 22

Web Reporter Web interface

Here is a sample of the Web Reporter interface with a description of 
some of the key features referred to in this guide.

Toolbars

Menu barShortcut bar

Navigation bar

Panels

Workspace
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Shortcut bar

The shortcut bar lets you quickly access various features such as 
subscriptions, shared reports, and preferences. You can also start a 
search from the shortcut bar. For more information, see Shortcut 
bar on page 27.

Navigation bar

The navigation bar displays below the shortcut bar. It shows the 
path you’ve followed in the software or the folder path for the 
current report. For more information, see Navigation bar on 
page 28.

Workspace

The workspace displays the feature you are currently using, for 
example, a report, a folder, a dashboard, or administrative forms.

In general, there are two types of workspace. The project workspace 
displays different folder pages for finding and opening reports, 
such as project home, project summary, report groups (folders), and 
reports lists. The reports workspace includes a menu bar, toolbars, 
and various panels for working with reports or documents.

Menu bar

The menu bar displays when you are working with a report or 
document in the reports workspace. It lists the options available 
based on your user level. Many of these options also appear as 
buttons on the various toolbars.

Toolbars

Toolbars in the reports workspace display commonly used options 
for quick access. The buttons and toolbars that display depend on 
your user level and on what you can do with the current report.
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Panels

Panels organize and display different kinds of information for 
quick reference. Panels let you interact with the software in 
different ways. You can learn more about a panel by clicking its 
Help button (a question mark). To hide a panel, click its Close 
button. If you close a panel, you can open it again by choosing it 
from the View menu.

Related topics

• Web Reporter user levels on page 13

• Terms on page 20

• Learning about Web Reporter on page 22

Terms

As you use Web Reporter, it will be helpful to understand these 
terms.

business intelligence

Business intelligence (BI) refers to technologies, applications, 
and practices for collecting, integrating, analyzing, and 
presenting key data that support better business decision 
making. Web Reporter is a business intelligence tool.

OLAP

Online Analytical Processing. OLAP is an approach to 
providing quick access to various multidimensional views of 
data without the need to make schema changes.

In Web Reporter, OLAP Services is an optional service.

schema

A schema defines the tables, fields, and relationships within a 
relational database.
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fact

Facts represent columns with numeric data in Web Reporter. 
They are the basis of metrics (calculations), for example, the 
number of checkouts or the price of an item.

metric

A metric is a calculation on a fact, for example, a sum of fines, a 
count of users of a given type, or the number of days an item is 
overdue.

attribute

In many cases, attributes are simply the columns or fields in 
your database tables, for example, a call number, a collection, 
or a postal code. However, an attribute may also represent 
some operation on a column or columns of data, for example, 
the day of the week for a given transaction or the quarter in 
which an invoice was paid.

filter

A filter lets you specify criteria that data must meet to be 
included on a report. Rarely will you run a report without some 
limit. Running a report without filters may take longer and in 
some cases may affect system performance. A filter is 
equivalent to the “where” clause in SQL.

prompt

A prompt is a list of options you can choose from as you run a 
report or an input for specific filter values.

report

A report is a collection of specific, sometimes filtered, data 
presented as rows and columns or a graph to help you analyze 
trends, identify problems, and plan for opportunities to better 
serve the users and institutions that support your library.

grid

The grid is the portion of the report displaying row and column 
data.
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graph

Graphs are graphical representations of report data, for 
example, a bar chart or pie chart, a line graph, a histogram, or a 
scatter diagram.

document

A document is a collection of data from one or more reports 
usually formatted for a specific purpose such as a dashboard or 
PDF. Documents can also include additional text, images, and 
hyperlinks.

dashboard

A dashboard is a special type of document that lets you 
integrate a number of reports, graphs, or gauges into a single, 
interactive view. Dashboards can provide quick access to 
frequently used features and information.

panel

A panel is a discrete, interactive area of a report or dashboard, 
usually set off with a border and a title bar. Panels are used to 
organize and display different kinds of information for quick 
reference.

Related topics

• Web Reporter user levels on page 13

• Web Reporter architecture overview on page 16

• Web Reporter Web interface on page 18

• Learning about Web Reporter on page 22

Learning about Web Reporter
Information about Web Reporter is available in several ways.
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Web Essentials Guide

This Web Essentials Guide is available in PDF or HTML format. Your 
system administrator will provide you with information about how 
to access the different versions.

SirsiDynix Training

SirsiDynix offers training specific to Web Reporter for Symphony. 
For information about available classes and schedules, visit the 
Training Center at http://sirsidynix.webex.com. For additional 
training needs, contact your SirsiDynix sales representative.

MicroStrategy Documentation

The MicroStrategy Business Intelligence Platform is delivered with 
extensive documentation. In addition to the online help available 
by clicking Help in the shortcut bar in Web Reporter, there are 
many PDF guides installed with the server software or Desktop 
client, including guides on basic and advanced reporting and 
document creation with Report Services.

Because the documentation is proprietary to MicroStrategy, you 
must be a licensed user to use these documents. Contact your 
system administrator about documents you can access.

Related topics

• Using Web Reporter on page 11

• About Web Reporter on page 12

• Getting around in Web Reporter on page 26

Logging in
To protect your library data from unauthorized access, you must 
log in to use reports in Web Reporter. Logging in also lets you save 
changes to reports, dashboards, and so on, so when you log in 
again, you can find the information you need more quickly.

http://sirsidynix.webex.com
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An administrator will assign you a username and password to log 
in to Web Reporter. You may change your password once you log 
in (see Changing your password on page 25).

Your username is not case-sensitive; for example, “user” and 
“uSeR” are equivalent. Passwords, however, are case-sensitive and 
must be typed exactly.

Depending on how your system administrator has configured 
privileges, your login may limit the data you can see and work 
with. If you need help logging in or have questions about access, 
contact your system administrator.

Before logging in, you should be sure your browser meets certain 
requirements. See Using Web Reporter on page 11 for more 
information.

To log in to Web Reporter

1 Open the login page.

2 Type your username and password.

3 Choose Login.

If your username and password are correct, the software starts 
a new session for you and displays your home view.

4 Be sure to log out when you finish using Web Reporter so 
others will not use your account and to free up server 
resources.

Related topics

• Logging out on page 25

• Using Web Reporter on page 11



Chapter 2: Getting Started

Logging out 25

Logging out
For your security, if you don’t do anything in Web Reporter for 
some time, the server will log you out automatically. However, 
when you finish using Web Reporter you should be sure to log out 
so that others will not use your account or make changes to it.

Also, logging out using the Logout option (instead of simply 
closing your browser) closes your session immediately, freeing up 
resources for other users. If you just close your browser, the session 
remains open on the server until it times out.

To log out of Web Reporter

Click the Logout option in the shortcut bar.

The software closes your session and confirms that you have 
been logged out.

Related topics

• Logging in on page 23

• Using Web Reporter on page 11

Changing your password
You can change your password at any time. You must log in to Web 
Reporter to change your profile. To learn more, see Logging in on 
page 23.

To change your password

1 Log in to Web Reporter if you haven’t already.

2 Choose your project if it is not already displayed.

3 Choose Preferences from the shortcut bar.

You must have permissions to change your password. If you 
cannot change your password, check with your system 
administrator.
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The Preferences page displays.

4 Choose Change Password from the list of preference groups on 
the left.

5 Type your old password in Old Password.

6 Type your new password in New Password.

7 Re-type your new password in New Password Verification.

8 Click Change Password.

Related topics

• Logging in on page 23

• Using Web Reporter on page 11

Getting around in Web Reporter
When you first log in to Web Reporter, you see a project list. After 
you select a project, the software displays your default start page 
(see Default Start Page on page 29). From there, getting to the 
features you want is fairly simple. Most features are just a few 
clicks away. All of the reports and features available to you are 
organized in folders. You can also collect frequently used reports 
and shortcuts in My Reports.

For details, see these topics:

• Shortcut bar on page 27

• Navigation bar on page 28

• Default Start Page on page 29

• Searching for reports on page 32

• Related reports on page 34

• Creating a shortcut to a report on page 61
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Shortcut bar

Wherever you are in the software, a shortcut bar displays at the top 
of the window. The shortcut bar provides quick access to common 
features. Clicking an option takes you to that feature.

The shortcut bar includes these features.

Feature Description

Shared Reports Shared Reports lists all the report groups you can 
use. These are reports delivered with the software 
or created by report designers in your library.

Reports are grouped into folders. Click a folder or 
the folder title to view reports or other folders in 
that group.

My Reports My Reports lists the reports, folders, and shortcuts 
that you have created.

Create Report Create Report begins the Create Report workflow. 
This option is only available if you are logged in as 
a Web Analyst or Web Professional (see Web 
Reporter user levels on page 13).

Create Document Create Document begins the Create Document 
workflow. This option is only available if you are 
logged in as a Web Professional (see Web Reporter 
user levels on page 13).

My Subscriptions My Subscriptions lets you manage the 
subscriptions you have created for scheduled 
reports.

History List History List shows the messages related to results 
for reports you have scheduled.

Preferences Preferences lets you modify options for viewing 
and working with reports (see Setting preferences 
on page 35). You can also change your password in 
Preferences (see Changing your password on 
page 25).
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Related topics

• Navigation bar on page 28

• Default Start Page on page 29

• Searching for reports on page 32

• Related reports on page 34

Navigation bar

As you open folders and documents, the navigation bar updates to 
show the path you’ve followed in the software or the folder path 
for the current folder or report. You can quickly return to a specific 
level by clicking a folder name or the project name in the path.

In addition to the path, the navigation bar includes these options.

Search The Search box lets you do a quick search by 
entering a word or words in the name of the report 
or document you want to find.

Click the search icon without entering a search 
term to open the Search page and specify 
additional options. (See Searching for reports on 
page 32.)

Help Help opens the MicroStrategy Web online help.

Logout Logout ends your current session and logs you out 
of the application (see Logging out on page 25).

Feature Description

Option Description

Home returns you to the project list.

Return returns you to the previous page or the parent level 
for a document or folder. In some cases, this is equivalent to 
clicking your browser’s Back button, but it helps to maintain 
session state.

Create New Folder lets you create a new folder. This option 
appears only in folder pages.
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Related topics

• Shortcut bar on page 27

• Default Start Page on page 29

• Searching for reports on page 32

• Related reports on page 34

Default Start Page

When you log in to Web Reporter and select a project, the software 
displays your default start page. This is also the page that displays 
whenever you click on the project name in the navigation bar.

You can specify your default start page in Preferences. Your start 
page can be the project Home view, the project Summary view, or 
one of the options in the shortcut bar, such as My Reports or 
History List. You can also specify a report or dashboard as your 
start page.

For more information about start page options, choose Help from 
the shortcut bar and refer to the User Preferences topic in the online 
MicroStrategy help.

The two most commonly used options are Home and Summary.

View: List This option is only available for folder pages and 
My Subscriptions. Clicking View: List displays folders, 
documents, and subscriptions in a table format with small 
icons.

Once enabled, this option applies to all folder pages and is 
persistent across sessions.

View: Icon This option is only available for folder pages and 
My Subscriptions. Clicking View: Icon displays folders, 
documents, and subscriptions as large icons with details 
beside the icon. This is the default view.

Once enabled, this option applies to all folder pages and is 
persistent across sessions.

Option Description



Chapter 2: Getting Started

30 Web Essentials Guide

Project Home view

The project Home view displays the major features you can work 
with depending on your user level and provides a brief description 
of each area. This is a good start page to work with if you are new 
to the software or use the software infrequently.
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Project Summary view

The project Summary view displays the same features as the Home 
view, but instead of descriptions of these features, the view shows 
some of the content of those features and allows you, for example, 
to work directly with subscriptions in My Subscriptions, messages 
in your History List, or report groups in Shared Reports or My 
Reports.

To set your default start page to Home or Summary

1 Log in to Web Reporter if you have not already.

2 Select a project.

3 Choose Preferences from the shortcut bar.

4 Select Home or Summary from the Default start page drop-
down list.

5 Scroll to the bottom of the User Preferences form and choose 
Apply. (You can choose to apply this change to the current 
project or all projects.)

The software confirms that your changes are saved.
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To set your default start page to a specific folder, report, or 
document

1 Log in to Web Reporter if you have not already.

2 Select a project.

3 Open the folder, report, or document that you want to use as 
your start page.

4 Choose Preferences from the shortcut bar.

The software displays a new option for default start page 
showing the name of the folder, report, or document you 
opened.

5 Select Last folder (or Last report or Last document depending 
on what you opened).

6 Scroll to the bottom of the User Preferences form and choose 
Apply. (You can choose to apply this change to the current 
project or all projects. Since folders, reports, and documents are 
typically project-specific, you should apply this change only to 
the current project.)

The software confirms that your changes are saved.

Related topics

• Shortcut bar on page 27

• Navigation bar on page 28

• Searching for reports on page 32

• Related reports on page 34

Searching for reports

Usually, you will find reports using folder pages. But if you can’t 
find a report you need, you can search for it by entering part of the 
name.

You can do a quick search by simply typing a string in the Search 
box in the shortcut bar, or click on the Search icon  without 
entering a term to open the Search page.
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Searches are not case-sensitive, for example, “user” and “User” are 
equivalent. By default, a simple search matches the string you type 
anywhere in the name (the search type is “contains”). You can 
choose Advanced on the Search page to specify additional options.

To search for a report or document by name

1 Click the search icon  in the shortcut bar without entering a 
search term.

The Search page displays.

2 Type part of the name in the search box.

3 Choose Search.

Related topics

• Shortcut bar on page 27

• Navigation bar on page 28

• Default Start Page on page 29

• Related reports on page 34

Search results will include matching reports and documents 
regardless of access controls. For example, you may see reports 
that you do not have permissions to access. If you try to open 
these reports, the software will return errors.
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Related reports

If there are several reports you work with in a given report group, 
you may find it helpful to use the Related Reports panel. The 
Related Reports panel is available in the reports workspace. As you 
open reports and documents, it lists the other reports and 
documents you have access to in the same report group.

To open another report or document in that group, you can just 
click on it in Related Reports without needing to return to the 
folder page.

Once you open the Related Reports panel, it stays open for all 
reports or documents until you close that panel again.

To view the Related Reports panel

1 Open a report or document.

2 Choose View > Related Reports.

To close the Related Reports panel

Click the Related Reports panel close button.
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Related topics

• Shortcut bar on page 27

• Navigation bar on page 28

• Default Start Page on page 29

• Searching for reports on page 32

Setting preferences
User Preferences let you configure options that fit the way you 
work. You can specify your preferences for such things as export, 
printing, drilling, grid and graph display, or prompts for example. 
User Preferences is also where you change your password.

For details on specific preferences, click Help in the shortcut bar 
and refer to the User Preferences topic.

To configure user preferences

1 Log in to Web Reporter if you have not already.

2 Select a project.

3 Choose Preferences from the shortcut bar.

The User Preferences General form displays with a list of 
preference groups you can configure on the left (for example, 
Export, Print, Prompts, and so on).

4 Choose the preference group you want to configure.

5 Specify your preferences.

Be sure to choose Apply for each preference group after making 
changes. If you switch to a different preference group before 
choosing Apply, your changes will not be saved.

You must have permissions to change user preferences. If you 
cannot change preferences, check with your system administrator.
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6 Choose Apply at the bottom of the form to save your changes. 
(You can choose to apply this change to the current project or 
all projects.)

The software confirms that your changes are saved.

7 Configure other preference groups as needed.

Related topics

• Getting around in Web Reporter on page 26

• Changing your password on page 25

• Default Start Page on page 29

• About Web Reporter on page 12
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Chapter 3: Basic User Tasks

This section describes the tasks a Web Reporter user can do. These 
tasks are common to all user levels. For more information about 
different license levels, see Web Reporter user levels on page 13.

• About reports on page 37

• Viewing reports on page 42

• About prompts on page 44

• Answering prompts on page 48

• Viewing report filters on page 49

• Using Page-by on page 50

• Sorting on page 52

• Drilling on page 55

• Printing a report on page 57

• Exporting a report on page 59

• Creating a shortcut to a report on page 61

• Report builder reports on page 62

About reports
Reports let you view and analyze your library data in many ways. 
Starting from a set of base reports, you can select and filter data to 
help you analyze trends, identify problems, and plan for 
opportunities in your library.
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The reports workspace displays data in various panels (see 
Elements of a report on page 39). Each panel shows report data or 
information about the report. Some panels let you interact with the 
data that displays. Once the report shows what you want, you can 
print the report or export the data for further analysis in another 
application.

The reports and documents you use are organized into folders or 
groups. Many reports are shared and appear in the Shared Reports 
folder. There may also be reports and shortcuts that only you can 
use. These are organized in My Reports.

The report options available to each user and the data that they see 
depend on privileges assigned to each user account. If you share a 
report with others who have different permissions than you, they 
may not see the report in the same way you do. If you have 
questions about access, talk to your system administrator.

For more information, see these topics.

• Elements of a report on page 39

• Types of report objects on page 41

• Viewing reports on page 42

• Printing a report on page 57

• Exporting a report on page 59

• Creating a shortcut to a report on page 61
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Elements of a report

Here is a sample of the reports workspace with a description of 
some of the key features referred to in this guide.

Menu bar

The menu bar lists the options available based on your user level. 
Many of these options also appear as buttons on the various 
toolbars.

Related Reports panel

As you work in the reports workspace, the Related Reports panel 
lists other reports and documents you have access to in the same 
report group. With this panel displayed, you can easily run other 
reports in the same group. For more information, see Related 
reports on page 34.

Toolbars
Menu bar

Related
Reports

panel

Graph

Grid

Report 
toolbar

Data 
selection
panels

Click the close 
button to hide a 

panel
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Toolbars

Toolbars display commonly used report options for quick access. 
The buttons and toolbars that display depend on your user level 
and on what you can do with the current report.

Report toolbar

The Report toolbar shows the amount of data currently displayed. 
Where there is more data than can display in a single view, the 
Report toolbar will also indicate the number of pages of data and 
which page is displayed. Links allow you to display other pages.

(This is different than the Page-by panel that allows the report 
designer to choose one or more attributes for grouping data. See 
Using Page-by on page 50.)

Data selection panels

Several panels show you information about limits currently 
applied to a report or let you select data to display.

Panel Description

Report Filter Shows the current filter selections in effect based on 
your answers to report prompts or limits assigned by 
the report designer. (See Viewing report filters on 
page 49.)

View Filter Lets Web Analyst or Web Professional users select a 
subset of the data returned with a report.

This panel is only available to Web Analyst or Web 
Professional users licensed for OLAP services.

Page-by Report designers can choose to group data by 
selected attributes or metrics. The Page-by Axis panel 
shows you the current group and lets you select other 
groups from a list. (See Using Page-by on page 50.)

Drill Lets you view and work with any drill maps included 
in a report. (See Drilling on page 55.)
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Graph

You can show or hide the Graph area for a report using the View 
menu or one of the Graph toolbar options.

Grid

The Grid area of a report displays data in rows and columns. You 
can show or hide the grid for a report using the View menu or 
toolbar options. You may also be able to click or right-click 
headings or data in a grid to do other actions, for example, sorting 
or drilling.

Related topics

• Viewing reports on page 42

• Types of report objects on page 41

Types of report objects

There are several types of report objects in Web Reporter each with 
a different icon to help you more easily recognize them in report 
folders.

Object 
Browser

Lets Web Analyst or Web Professional users add or 
remove data elements on a report.

Grouping The Grouping panel displays only for documents. 
Document designers can choose to group data by 
selected attributes. The Grouping panel shows you 
the current group and lets you select other groups 
from a list.

Panel Description

Icon Description

Folder Folders group reports, documents, shortcuts, and 
other folders to help you better organize the report objects 
you work with.
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Related topics

• Viewing reports on page 42

• Elements of a report on page 39

Viewing reports
Reports and documents are generally organized by functional area 
in either Shared Reports or My Reports. Some reports and 
documents execute directly; others may have prompts to let you 
limit the data (see Answering prompts on page 48). In either case, 
just click on the report or document you want to view to start the 
process.

Some reports take longer than others to return results. When you 
run a report, a Processing Request page may display to indicate 
that the report is still running. This page automatically updates 
periodically, but you also have the option to check status again or 
cancel the report.

Grid report A report with only a grid to show data.

Grid and graph report A report that displays data in both 
grid and graph formats.

Graph only report A report with only a graph view; grid 
data is hidden.

Document A document collects data from one or more 
reports and displays as a dashboard in HTML or Flash or as 
a PDF.

Shortcut You can create shortcuts to any report object. The 
icon for a shortcut adds a small arrow to the lower-left 
corner of the usual object icon, as in this example of a 
shortcut to a grid report (see Creating a shortcut to a report 
on page 61).

Icon Description
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Your system administrator can limit the maximum execution time 
for reports (the time it takes to return report results once you start 
the report process, including time you spend answering prompts). 
The default is 10 minutes. If a report takes longer than the 
maximum, the software will return an error. If a report takes too 
long or does not return any data, try changing your answers for 
any prompts and run the report again.

Your system administrator can also configure caching. Caching 
saves the results of a report for a brief period. If you need to run the 
same report again with the same answers to prompts and the 
results are still cached, you will notice that the report loads more 
quickly.

After results are displayed, you can choose Refresh from the Data 
menu (or use the Refresh option on the toolbar) to update the 
results with the latest data without having to answer prompts 
again. If you want to change some of your answers for prompts, 
you can choose Reprompt.

For more information about the reports workspace, see Elements of 
a report on page 39.

To view a report

1 Use the folders in Shared Reports or My Reports to locate the 
report you want.

2 Click on the report.

3 Answer prompts if any (see Answering prompts on page 48).

4 Choose Run Report.

The software executes the report and either returns results or 
reports status or errors.
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Related topics

• About reports on page 37

• About prompts on page 44

• Answering prompts on page 48

• Viewing report filters on page 49

• Using Page-by on page 50

• Sorting on page 52

• Drilling on page 55

• Printing a report on page 57

• Exporting a report on page 59

• Report builder reports on page 62

About prompts
Some reports include prompts to let you select and limit data. Each 
prompt has a title bar and sometimes a description explaining the 
expected input. The title bar also indicates if the prompt is required. 
Information about valid and default values appears below the 
prompt.

Description and 
details

Prompt 
input

Summary Title bar
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If there is more than one prompt for a given report, a summary 
displays the prompt titles for each prompt. In User Preferences > 
Prompts, you can choose if you want to display all prompts in a 
single page or each on a separate page. (See Setting preferences on 
page 35 for more about user preferences.)

When prompts appear on separate pages, you can use the Next and 
Previous buttons to move among prompts, or you can simply click 
the prompt title in the summary to go to a specific prompt.

The report designer determines the prompt style. For example, a 
prompt may be a simple text box; a list of check boxes or radio 
buttons; a drop-down list; or selection lists. These prompts function 
like any Web form. The date prompt and the cart-style prompt have 
additional functionality.

Date prompt

A date prompt lets you specify a date by typing or by selecting it 
from a calendar.

You type a date with slashes using m/d/yy or m/d/yyyy format, 
for example 8/15/2008.

The date format may vary depending on the date format specified 
in user preferences.
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Or you can select a date by clicking the calendar button. If the date 
range is limited by the report designer, dates outside the range will 
be inactive.

Cart-style prompt

The cart-style prompt lets you select multiple options. Shift-click to 
select a range of options; Ctrl-click to select additional options one 
at a time. You can also Ctrl-click a selected option to clear the 
selection. Double-click options or use the Add/Remove arrow 
buttons to move options from one list to the other.

Sometimes the number of options available may exceed the 
Available list size. In this case, the software will show the number 
of current options, with arrows to display the next or previous set 
of options.

The order of selected options is significant. For metrics and 
attributes that appear in columns of a report, the order in which 
you add options to the Selected list determines the order in which 
those options appear in the report. By default, options are added to 
the bottom of the list. But you can control where options are added 
by selecting an option in the Selected list; other options will be 

The calendar button will not display if you have disabled 
Dynamic HTML in user preferences.
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added above the selection. For example, if you have IrU-Mu and 
NIC-Mu in the Selected list and NIC-Mu is selected, the next 
options you add will appear between IrU-Mu and NIC-Mu instead 
of at the bottom of the list.

Where there are many options in the Available list, the Search For 
feature lets you limit the list to those options that match a search 
string you specify. The default search mode is “contains”, meaning 
the string you type can appear anywhere. For example, typing “N” 
will find all options with N anywhere in the value. You can use 
asterisk (*) to trigger left, right, or middle truncation. The asterisk 
represents zero or more characters. For example, “N*” will display 
all options beginning with the letter N.

If Dynamic HTML is disabled in user preferences, options are only 
added to the bottom of the list regardless of what is selected in the 
Selected list.
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Related topics

• About reports on page 37

• Viewing reports on page 42

• Answering prompts on page 48

• Viewing report filters on page 49

• Using Page-by on page 50

• Sorting on page 52

• Printing a report on page 57

• Exporting a report on page 59

• Report builder reports on page 62

Answering prompts
Rather than create a static report that always displays the same 
information, a report designer may add prompts to a report to let 
you select what filters to use and what data to include in the report.

Some prompts are required. If you fail to answer a required 
prompt, when you choose Run Report the software will return you 
to that prompt and remind you that it is required.

In some cases, the prompts you answer limit options in subsequent 
prompts. For example, you may be prompted to select a fund 
library so that the software can display funds specific to that 
library, or you may be prompted to select specific filters and then 
prompted to select options for those filters.

After results are displayed, you can choose Report Filter from the 
View menu (or use the Report Filter option on the toolbar) to view 
the filters applied based on your answers to prompts (see Viewing 
report filters on page 49). If you want to change some of your 
answers for prompts, you can choose Reprompt from the Data 
menu (or use the Reprompt option on the toolbar).
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To answer prompts while executing reports

1 Open a prompted report.

2 Specify options according to the prompt style (see About 
prompts on page 44).

3 Choose Run Report to continue the report process.

Related topics

• About reports on page 37

• Viewing reports on page 42

• About prompts on page 44

• Viewing report filters on page 49

• Using Page-by on page 50

• Sorting on page 52

• Drilling on page 55

• Printing a report on page 57

• Exporting a report on page 59

• Report builder reports on page 62

Viewing report filters
As you work with reports, the Report Filter feature lets see how 
report data has been limited by the report designer or by your 
answers to report prompts.

The Report Filter panel displays below toolbars in the reports 
workspace (see Elements of a report on page 39).

Once you enable the Report Filter panel, it will display 
automatically for subsequent reports.
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To view report filters

1 Execute a report.

2 Choose View > Report Filter (or click the Report Filter option 
 on the toolbar).

The software displays the Report Filter panel. (If the Report 
Filter panel is already displayed, choosing Report Filter hides 
the panel.)

Related topics

• About reports on page 37

• Viewing reports on page 42

• Answering prompts on page 48

• Using Page-by on page 50

• Sorting on page 52

• Drilling on page 55

• Printing a report on page 57

• Exporting a report on page 59

• Report builder reports on page 62

Using Page-by
Reports generally have two axes (rows and columns), but if a report 
has many attributes or metrics, it may be difficult to view. To make 
it easier to view and understand the data, a report designer can 
group data along a third axis called the Page-by axis.
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The Page-by axis may include one or more elements. It lets you 
view smaller sections of a report one page at a time.

Once you enable the Page-by panel, it will display automatically 
for subsequent reports. This lets you know immediately if a report 
uses Page-by.

To view sections of a paged report

1 Open a report.

2 If the Page-by panel is not already displayed, choose View > 
Page-By Axis (or click the Page-by Axis option  on the 
toolbar).

3 Select the page you want to view from a drop-down list in the 
Page-by panel.

If Dynamic HTML is disabled in user preferences, a Go button 
appears next to the list. Click Go after selecting an option from the 
list to view that page.
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Related topics

• About reports on page 37

• Viewing reports on page 42

• Answering prompts on page 48

• Viewing report filters on page 49

• Sorting on page 52

• Drilling on page 55

• Printing a report on page 57

• Exporting a report on page 59

• Report builder reports on page 62

Sorting
In Web Reporter, you can sort data in two ways.

If you want to sort a single column, you can simply right-click a 
column heading and choose a sort option.

Sometimes, however, it’s useful to sort multiple columns. Say, for 
example, you were viewing a report that showed collection value 
by item type for many libraries.
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You’d like to see the highest value item types first. If you simply 
sort by Item Price, all the libraries would be mixed together.

A multi-column sort lets you first sort by library ascending then by 
Item Price descending.

This preserves the library groups and the totals for each library 
while showing the highest value item types first.
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To sort a single column

1 Execute a report.

2 Right-click on the heading for the column you want to sort.

3 Choose Sort > Ascending or Sort > Descending from the menu 
that appears.

The software refreshes the report using the sort you specified.

To sort multiple columns

1 Execute a report.

2 Choose Data > Sort (or click the Sort option  on the toolbar).

The Sort window displays.

3 Specify sort options for the columns you want to sort.

4 Choose OK.

The software refreshes the report using the sort you specified.

Related topics

• About reports on page 37

• Viewing reports on page 42

• Answering prompts on page 48

• Viewing report filters on page 49

• Using Page-by on page 50

• Drilling on page 55

• Printing a report on page 57

• Exporting a report on page 59

• Report builder reports on page 62

If Dynamic HTML is disabled in user preferences, you must first 
choose “Show sort buttons” and then click a sort button in the 
column heading.
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Drilling
Some reports let you drill to see additional information related to 
the current report. For example, you may be able to drill through to 
a list of titles from a collection report or drill through to contact 
information from an overdue fines report. The ways you may drill 
are defined by the report designer.

In some reports, drill options may appear as links. You can simply 
click a data element to drill through to related data.

In other reports, fields that allow drilling may not be obvious. If 
you know that a particular field in a report allows drilling, when 
the Drill panel is not displayed you can right-click a data element in 
the list and choose a drill option from the menu that appears.

You can also use the Drill panel to view drilling options for a 
report. You open the Drill panel by choosing Data > Drill or clicking 
the Drill option  on the toolbar.



Chapter 3: Basic User Tasks

56 Web Essentials Guide

When the Drill panel is open, fields in the Drill panel that allow 
drilling will display an Apply button, and data elements in the 
report grid will display with check boxes. To drill, in the grid select 
the data elements you want to drill on; in the Drill panel select the 
data to drill to and choose Apply.

Be careful to select specific data elements before drilling. If you do 
not make any selections, the software will attempt to drill on all 
elements, which could return a lot of data.

When you drill in a report, the results may display in a new 
window depending on selections in User Preferences > Drill Mode.

To drill in a report using Drill panel

1 Open a report that allows drilling.

2 Choose Data > Drill (or click the Drill option  on the 
toolbar).

The Drill panel opens and the software displays check boxes 
for each data element in the grid.

Web Analyst and Web Professional users may have additional 
drilling options. Refer to the MicroStrategy online help for 
information about advanced drilling.
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3 Select the data elements you want to drill on.

4 Select the data to drill to from a list in the Drill panel.

5 Choose Apply for that field.

The software executes the report using the drill you specified.

Related topics

• About reports on page 37

• Viewing reports on page 42

• Answering prompts on page 48

• Viewing report filters on page 49

• Using Page-by on page 50

• Sorting on page 52

• Printing a report on page 57

• Exporting a report on page 59

• Report builder reports on page 62

Printing a report
You can print reports using your browser or using PDF depending 
on whether “Use PDF for printing reports” is selected in User 
Preferences > General > Output Formats (see Setting preferences on 
page 35).
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When “Use PDF for printing reports” is selected, you will see only 
a “Print (PDF)” preference group in preferences and the Print and 
PDF options in the reports workspace are essentially the same. 
When “Use PDF for printing” is clear, there are separate preference 
groups for Print and PDF. You can specify options for each 
independently.

The Show Options option in the Print, PDF, and Print (PDF) 
preference groups specifies if the software should prompt you each 
time you print a report. If you are prompted to choose options 
when printing and you choose “Do not prompt me again”, the 
software clears the Show Options option and saves your settings to 
preferences to use for all future print requests.

There are no options when printing documents.

To print a report

These steps assume your preferences are set to show options when 
printing.

1 Open the report you want to print.

2 Choose File > Print (or click the Print option  on the 
toolbar).

The software displays print options in a new window.

3 Specify print options.

(Choose Help from the shortcut bar for details on specific 
options.)



Chapter 3: Basic User Tasks

Exporting a report 59

4 Choose Show Printable Version.

The software formats the report for printing based on your 
selections and then displays the report as HTML or PDF.

Note: If you print to PDF and do not have a PDF reader 
installed, your browser will prompt you to save the file instead 
of displaying it.

5 Use the print feature in your browser or PDF reader to print the 
file.

Related topics

• About reports on page 37

• Viewing reports on page 42

• Answering prompts on page 48

• Viewing report filters on page 49

• Using Page-by on page 50

• Sorting on page 52

• Drilling on page 55

• Exporting a report on page 59

• Report builder reports on page 62

Exporting a report
You can export report data to a number of file formats including 
HTML, CSV (comma-separated values), plain text, or Excel, 
depending on preferences in User Preferences > Export (see Setting 
preferences on page 35).

The Show Options option in the Export preference group specifies 
if the software should prompt you each time you export a report. If 
you are prompted to choose options when exporting and you 
choose “Do not prompt me again”, the software clears the Show 
Options option and saves your settings to preferences to use for all 
future export requests.
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You may export the whole report or only the portion of the report 
currently displayed.

To export report data

These steps assume your preferences are set to show options when 
exporting.

1 Open the report you want to export.

2 Choose File > Export (or click the Export option  on the 
toolbar).

The software displays export options in a new window.

3 Specify options for export.

(Choose Help from the shortcut bar for details on specific 
options.)

4 Choose Export.

The software creates a new file using the options you specified 
and returns it to your browser. Your browser will prompt you 
to save or open the file.

Related topics

• About reports on page 37

• Viewing reports on page 42

• Answering prompts on page 48

• Viewing report filters on page 49

• Using Page-by on page 50

• Sorting on page 52

• Drilling on page 55

• Printing a report on page 57

• Report builder reports on page 62
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Creating a shortcut to a report
If there are reports you work with frequently from various report 
groups, it may be helpful to create shortcuts and access them from a 
common group in My Reports, for example.

To create a shortcut to a report

1 Use the folders in Shared Reports or My Reports to locate the 
report you want.

2 Right-click on the report.

3 Choose Create Shortcut from the menu that appears.

A window opens prompting you to select a location for the 
shortcut.

4 Locate the folder where you want to save the shortcut. You can 
create a new folder using the Create New Folder option .

5 Choose OK.

The shortcut is created in the folder you specified.

Related topics

• About reports on page 37

• Viewing reports on page 42

• Printing a report on page 57

• Exporting a report on page 59

The Web Reporter user level does not allow deleting folders or 
shortcuts. If you need to delete a folder or shortcut and you do not 
see a Delete option when you right-click report objects in My 
Reports, talk to your system administrator.
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Report builder reports
The Web Reporter user level does not allow creating reports. 
However, report designers can create fully prompted reports that 
allow you to select from lists of attributes, metrics, and filters to 
define potentially hundreds of different reports. Several reports like 
this are delivered with the software and include the term “Report 
Builder” in the report name. (This approach to designing reports is 
similar to the Report Builder tool available in the MicroStrategy 
Desktop application.)

When you use report builder reports, you must select at least one 
attribute and at least one metric if any. Filters are often optional, but 
if you do not specify a filter, the report may return a lot of data.

The order in which you select attributes and metrics is the order 
they appear in the report. (For more information, see About 
prompts on page 44.) For example, if you want to create a report 
about holds grouped by library, you would select the library 
attribute first, then the hold attributes you want.

To use a report builder report

1 Use the folders in Shared Reports to locate the “Report 
Builder” report you want.

2 Click on the report.

3 Select the attributes and metrics for your report (see Answering 
prompts on page 48). Be careful to consider the order of your 
selections.

4 Select one or more filters for your report. (It’s a good idea to use 
at least one filter or the report may return a lot of data.)

5 Choose Run Report.

The software evaluates your selections and prompts you to 
specify filter criteria for any filters you selected.

Web Analyst and Web Professional users can rearrange columns 
after running a report. The Web Reporter user cannot.
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6 Select options for the filters you specified.

7 Choose Run Report.

The software executes the report and either returns results or 
reports status or errors.

If the report does not return the data you want, choose 
Reprompt and modify your selections.

Related topics

• About reports on page 37

• About prompts on page 44

• Viewing report filters on page 49

• Using Page-by on page 50

• Sorting on page 52

• Drilling on page 55

• Printing a report on page 57

• Exporting a report on page 59
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